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Preview

Kudo maintains a link between the thumbnail image in the catalog and the original file.    While in Kudo 
use the Preview option to preview the original image file in a full-sized window.    

1. Select the thumbnail you wish to preview.
2. Choose Preview from the Image menu.
3. Kudo will find the original image file and display it in a full-sized window. 
4. Double-click the Control menu to exit the preview.

To preview other image files, simply click their thumbnails while the Preview
window is open.    

Note:    Kudo can not preview files stored on removable media (i.e. floppy disks, removable 
cartridges, etc.). If the file is not present in your system, Kudo will ask you to insert the correct 
disk. 



Drag and Drop Images from Kudo

There are three methods for placing an image from a Kudo catalog into a document:
Drag and Drop.
Copy and Paste.
You can also, of course, note the file name and location and use it to insert the image from within the target 

application.

Kudo takes advantage of Windows technology (DDE and OLE 2.0) which allows you to Drag and Drop 
images onto all popular graphics applications.    Drag and Drop from your Kudo catalog to an open 
document will find the original image file and place it in the document of selected desktop publishing 
and other page layout applications, with pinpoint accuracy.

To Drag and Drop a thumbnail to an open document: 
1. Select the thumbnail.
2. Hold down the mouse button and drag it to the open document.

Note:    Pinpoint accuracy requires an OLE 2.0 client application or a special Kudo Place Module.    
Place Modules are included for MS Word, PageMaker, QuarkXPress, and Word Perfect.

Note: The Place Module for the application you are using must be installed in the Kudo    directory.    The
format of the file being placed must be supported by that application.    The cursor will indicate a plus (+)
or a document symbol (q) if the target application supports the file being placed and the "not cursor (¦) if 
the target application does not.

Note:  For Microsoft Word users, Word will indicate that you can drop the image only when the cursor is
over the Word application tool bar or the status bar (along the bottom of the window).    When the image 
is dropped, it will be inserted at the exact location of the Word "I-beam" (insertion point).    Release the 
mouse button and Kudo will find the image file and place it into the document. 



Sorting

When you open a catalog, Kudo lists the thumbnails according to when they were added to the catalog. 
Use the Sort menu to list the thumbnails by file size, date or even location.    For example, sort by 
"Modification Date" to see which image files have been recently updated or sort by "Kind" to group 
images by file type.    You can sort the catalog using the same criteria found in the Find feature.

Sort and Find use the same criteria but they affect the catalog differently.    With Find you use the criteria
to determine which thumbnails Kudo should display and which it should hide from view.    With Sort you 
re-arrange the thumbnails that are displayed.

When you close and re-open the catalog, Kudo shows all the thumbnails in their original order.

To sort your catalog:
1. Select sorting criteria from the Sort menu.
2. Kudo will automatically re-arrange the thumbnails and display them in their new order.



Printing Your Catalog

Use the standard Printer Setup and Print commands to print part or all of your catalog.    The Print 
feature always prints the current selection of thumbnails.    For example, to print all thumbnails in a 
catalog, use Find All    to find "everything" (the default), and then select print from the File menu.

To print thumbnails with file name and size only, select Gallery View prior to printing your catalog.    
Printing a catalog in Gallery View prints the maximum number of thumbnails per page. To print 
thumbnails with complete information, including file location, select List View and then print the catalog.  
Printing a catalog in List View provides more text information on images but prints fewer thumbnails on 
each page.



Using Copy and Paste

You will be able to drag and drop images to all leading graphics applications.    They all support 
Windows Drop-onto, and for pinpoint accuracy, many even offer OLE 2.0 (client) support.    For other 
applications and older Windows 2.x applications that do not have these capabilities, you can still place 
an image using copy and paste.

To use Copy and Paste:
1. Select the thumbnail image.
2. Choose "Copy Thumbnail" under the Edit menu.
3. Kudo will find the original image file and copy it to the clipboard.
4. Open the target document.
5. Choose "Paste" under the Edit menu of the target document.
6. Your target application will paste the image onto the document page.

Note:    When you use copy, the entire original image file is placed on the clipboard.    Be sure 
you have enough RAM to support this action.



Contacting Technical Support

VOICE:
Technical Support is available Monday through Friday, 8:00 a.m. - 5:00 p.m. PST., at 619-272-2600.

FAX:
Questions can be faxed 24 hours a day, 7 days a week.    Fax your questions to 
619-272-4292.    You will receive an answer to your fax within 24 business hours.

BBS:
The Imspace Systems Bulletin Board System (BBS) is available 24 hours a day, 7 days a week by 
dialing 619-272-3420.    The BBS supports baud rates from 300 - 14.4k bps. at 8 bits, no parity, and 1 
stop bit.    Please address technical issues to "Tech Support" and general questions and comments to 
"SysOp".



File Menu

Print 
Print Setup 
Exit 



Edit Menu

Copy Text 
Paste Text 

Copy Thumbnail 
Paste Thumbnail 



View Menu

Gallery View 
List View 
Small Gallery View 



Image Menu

Preview 
Get Info 
Find 
Find All 

Rotate Thumbnail 
Flip Thumbnail 
Place 



Sort Menu

Name - Sorts thumbnails by their eight character file name
    Size - Sorts thumbnails by the size of the actual image size
    Kind - Alphabetically groups thumbnails by their image type (extension)
    Date - Sorts thumbnails by the date the image file was Last modified

                Location - Sorts thumbnails by the image file's location pathname
Notes - Sorts thumbnails by the first word in the Notes Box



Window Menu

                Cascade - Displays open catalogs in standard WIndows Cascade view
      Tile - Displays open catalogs in standard Windows Tile view

Arrange Icons - Organizes all iconized catalogs in the Kudo window
              Close All - Closes all catalogs open and returns to Kudo window



Print Setup

Print Setup, as in most Windows applications, gives options to select available printers and change their
options.



Exit

The Exit command closes and saves all open catalogs then closes Kudo.



Get Info

Get Info gives you quick access to a thumbnail's information.    This option tells you the file kind, volume,
size and any notes you have attached to the thumbnail.

To display a thumbnail's information:
1. Select a thumbnail.
2. Select "Image-Get Info"
3. Kudo will display the information in a floating window. 

You can also display the Info Window using the Info Button.    When the Info window is open, click other 
thumbnails to display their information.    Close the window by double-clicking on the window's Control 
menu.



Find

Use the Find feature to search the catalog for thumbnails with specific characteristics.    Kudo searches 
the catalog and displays the thumbnails that were identified in the search.    All other thumbnails are 
hidden from view.

For example, if you search the catalog's notes for a client name, Kudo only displays the thumbnails with
that information only.    Kudo does not delete or edit the remaining thumbnails; it just hides them from 
view.    To return to the full catalog, use Find to search the catalog for "Everything" or select "Find-All" 
from the "Image" pull-down menu. 

When you select the Find feature, Kudo displays the Find Image dialog box.    
Use the first combo box to tell Kudo the thumbnail characteristic it should search.    You can search by name,

size, date modified, notes or location.

Use the next combo box menu to tell Kudo how to search the catalog.    The selections in this combo box will
become available after you make a selection in the first combo box.

Use the edit text box to tell Kudo what words or information to search for.    Wild card characters such as "*" 
or "?" are not necessary.

You can also choose the Find option using the Image menu.    For example, you may have a catalog 
that includes a series of aircraft clip art images.    You can use the Find button to search the catalog for 
any thumbnail records whose notes contain the word "Plane".    To return to the full catalog, use Find 
and choose "Everything" or select Find-All from the Image pull-down menu. 



Find All

Find All searches for and displays all thumbnails in the active catalog.    This feature is also used to 
restore all thumbnails after a Find operation.    Find All is equivalent to exectuing a Find "Everything" 
using the Find Button.



Rotate Thumbnail

The selected thumbnail will be rotated 90 degress clockwise.    The last thumbnail position will be saved 
when the catalog is closed.    The image file is not affected by the feature.



Flip Thumbnail

The selected thumbnail will be flipped (reversed) horizonally.    The last thumbnail position will be saved 
when the catalog is closed.    The image file is not affected by the feature.



Place

Place copies an image file from the clipboard places (pastes) the image into a Kudo supported 
document.



Exploring the Kudo Image Browser Window

This is a typical Kudo Window displaying two catalogs.    The catalog on the left is displayed in Gallery 
View and the catalog on the right in List View.    Explore the Kudo Window by clicking an item in the 
Kudo window below.
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Drag and Drop Compatibility

Drag and Drop can be used from Kudo Image Browser onto the following applications:

All graphics applications that support Drag and Drop from the File Manager.    This includes virtually all 
leading applications.

All graphics, desktop publishing, and multimedia applications that are OLE 2.0 clients.    OLE 2.0 clients 
provide pinpoint accuracy when dropping onto a page layout.

In addition to the above, Kudo includes Place Modules for the following applications that are not OLE 
2.0 clients, but could benefit from Drag and Drop with pinpoint accuracy:

QuarkXPress version 3.12 , 3.2 and 3.3
Aldus PageMaker version 4.2 and 5.0
Microsoft Word version 2.0
Word Perfect 6.0
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Troubleshooting

Nothing happens when you drag a thumbnail into a PageMaker or QuarkXPress document.    
Applications such as PageMaker and QuarkXPress only support the importing of specific file formats.    
If a file format is not supported by the application you are using, nothing will happen when you drag the 
Kudo thumbnail into the application document.    Consult the documentation provided with the 
application to determine which file formats are supported, or copy and paste the thumbnail from Kudo.



Un-installing Kudo

To un-install Kudo Image Browser, simply delete the following:
The Kudo directory and all of its contents.
The Kudo program group item.
The Kudo program group from the Program Manager.

Warning:    please make sure that any catalogs and/or other files you wish to retain are moved 
from the Kudo directory before it is deleted.



Welcome to Kudo Image Browser

Welcome to Kudo Image Browser, the new way to organize your image files.    Kudo is an image 
catalog.    Just as you consult an office supply catalog for desk calendars, legal pads or pens, consult 
your Kudo catalog for your logos, clip art, illustrations, Microsoft Videos, QuickTime movies and Kodak 
Photo CD pictures.

Kudo catalogs your image files using thumbnails.    Think of a thumbnail as a miniature photo of your 
image file.    It looks like your file, but it's a replica that takes up very little memory.    Kudo uses the 
thumbnail in its catalog and leaves your image file, untouched, in its original form and location.    With 
these compact thumbnails, Kudo catalogs your image files in a convenient, accessible way.

The thumbnails provide a visual reference for each image file.    Kudo adds additional information, such 
as the original file's name, location, size and file type, to complete the catalog.



Why Use Kudo

You have hundreds of clip art, logos and other graphic image files on your computer, all created using 
different applications.    Unfortunately, to look through your images, you must find and open each file. 

With Kudo, you can:
Zoom through the catalog to locate the image file's thumbnail.
Reference the image file's location, size and format.
Preview the full-sized image in a floating window.
Place the image into another document.

Kudo saves you hours of time.    You've been there . . .

You want to find a graphic file so you search, open a file, close it.    Search, open another file, close it.    
And on and on.    That's the old way to find an image.

As a graphic design professional, you have hundreds, or even thousands, of images created for 
projects or collected from commercial clip art sources.    You may subscribe to services that provide 
images monthly, stored by the hundreds, on CDs.

You have a photograph or piece of artwork in mind that would fit perfectly in your new layout.    The 
question is:    "Where did I see that image?".    While you have seen it a hundred times, can you find it 
now?    Would    it be faster to re-create the image or use another that you can find that is "close 
enough"?    Kudo Image Browser is a time-saving tool designed to allow more opportunity for originality 
and design because less time is spent searching for images.

You need the image of a sunset for your current project.    Kudo presents you with thumbnails of all your 
image files.    Now you can see exactly what the image in each file looks like.    Using the Riffle Control, 
you quickly zoom through the catalog until you see the one you want.    The search has become as 
simple as riffling the pages of a photograph album.

Once you find an image that will work, you preview it with a simple menu selection.    When you are 
satisfied with the selection, you simply Drag and Drop the image directly into your favorite graphics or 
desktop publishing application.

Selecting artwork from a catalog has become a visual search.    With Kudo Image Browser, you quickly 
browse, preview and select graphics and multimedia files.    Your attention can now be focused on 
content and creative tasks, rather than wasting time locating the right image file.



Find Button

Use the Find button to search the catalog for thumbnails with specific characteristics.    Kudo searches 
the catalog and displays the thumbnails that were identified in the search.    All other thumbnails are 
hidden from view.

For example, if you search the catalog's notes for a client name, Kudo only displays the thumbnails with
that information.    Kudo does not delete or edit the remaining thumbnails; it just hides them from view.    
To return to the full catalog, use Find to search the catalog for "Everything" or select "Find-All" from the 
"Image" pull-down menu. 

When you select the Find feature, Kudo displays the Find Image dialog box.    
Use the first combo box to tell Kudo the thumbnail characteristic it should search.    You can search by name,

size, date modified, notes or location.

Use the next combo box menu to tell Kudo how to search the catalog.    The selections in this combo box will
become available after you make a selection in the first combo box.

Use the edit text box to tell Kudo what words or information to search for.    Wild card characters such as "*" 
or "?" are not necessary.

You can also choose the Find option using the Image menu.    For example, you may have a catalog 
that includes a series of aircraft clip art images.    You can use the Find button to search the catalog for 
any thumbnail records whose notes contain the word "Plane".    To return to the full catalog, use Find 
and choose "Everything" or select Find-All from the Image pull-down menu. 



Info Button

The Info button gives you quick access to a thumbnail's information.    This option tells you the file kind, 
volume, size and any notes you have attached to the thumbnail.

To display a thumbnail's information:
1. Select a thumbnail.
2. Click the Info button.
3. Kudo will display the information in a floating window. 

You can also choose Get Info using the "Image" pull down menu.    When the Info window is open, click 
other thumbnails to display their information.    Close the window by double-clicking on the window's 
Control menu.



Scroll Bars

Use the Scroll bar to move forward and backward through the catalog.    

Remember that Kudo will display the catalog based on the current Find criteria.    If you have selected 
"Everything" in the Find feature, the entire catalog is available.    However, if you have used Find to 
select a specific group of files, you can only scroll through those files.    You must set new search criteria
to scroll through your other thumbnails.



Thumbnail View Buttons

The Gallery View and List View buttons allow you to toggle between views.    Switch between the views 
by clicking the view button you prefer.

The Gallery View uses a grid style layout showing several thumbnails and their file type 
at once.    Click the Info button to view detail about the selected thumbnail.

The List View uses a vertical layout with fewer thumbnails in the window, but with more 
information about each file.    The list view shows the thumbnails in a vertical column and 
the file information in a second vertical column.
 

Note:    The list view also shows your notes or description of the thumbnail.    With Kudo, you can
edit these notes on-the-fly.    Add, delete or change text by simply keying in your notes.    Use 
standard Windows text editing commands to edit your notes. 



Gallery View

The Gallery View uses a grid style layout showing several thumbnails and their file type at once.    Click 
the Info button to view detail about the selected thumbnail.

The Gallery View and List View  buttons allow you to toggle between views.    Switch between the views 
by clicking the view button you prefer.



List View

Unlike Gallery View, List View uses a vertical layout with fewer thumbnails in the window, but with more 
information about each file.    The list view shows the thumbnails in a vertical column and the file 
information in a second vertical column.
 
The list view also shows your notes or description of the thumbnail.    With Kudo, you can edit these 
notes on-the-fly.    Add, delete or change text by simply keying in your notes.    Use standard Windows 
text editing commands to edit your notes. 



Small Gallery View

The Small Gallery View uses the same layout as Gallery, but with much smaller images allowing the 
user to view more images at once.    Click the Info button to view detail about the selected thumbnail.



Help Menu

The Help menu displays this file and the Kudo "About" Window.



Status Bar

The Status Bar displays the number of thumbnails currently displayable out of the total thumbnails 
contained in the active catalog.    

For example, the active catalog contains 100 thumbnails.    After executing the    Find feature, only 35 
thumbnails met the search criteria.    The catalog window will only display the 35 found thumbnails and 
the Status Bar will display "35 of 100".

To restore the catalog to the full 100 displayable thumbnails, use either the Find All option from the 
"Image Menu" or find "Everything" using the Find Button 



Title Bar

A window's Title Bar displays the name of the open application (in this case, Kudo Image Browser) or 
the path/filename of the catalog or both application name and path/filename of catalog.



Control Menu

The Control Menu provides options to close the window and control its sizing.



Maximize & Minimize Window

The Maximize (up arrow) and the Minimize (down arrow) buttons are stanard Windows options.    

Maximize enlarges the current window size to full screen. 
Minimize reduces the current window to an icon on your computer's desktop.    

To display the window, click on the icon.



Thumbnail Information

In List View, the thumbnail's information section tells you the file kind, volume, size and any notes you 
have attached to the thumbnail.

You can also display the Info Window using the Info Button.    When the Info window is open, click other 
thumbnails to display their information.    Close the window by double-clicking on the window's Control 
menu.



Copy Text

Copy Text copies text to the clipboard from the selected thumbnail.



Copy Thumbnail

Copy Thumbnail copies a thumbnail to the clipboard from a selected catalog.



Paste Text

Paste Text copies text from the clipboard into the selected application.



Paste Thumbnail

Paste Thumbnail copies a thumbnail from the clipboard to a selected catalog.



Riffle Feature

The Riffle feature displays the selected catalog's thumbnails one at a time in the lower right corner of 
the main window. 

Control the Riffle speed and direction by holding down the left mouse button and dragging the control 
bar from the center to the left or right of the Riffle Control.    Kudo will advance through the catalog until 
you release the control or until it reaches either end of the catalog.    

When the mouse button is released or the control bar is returned to the center position, Kudo stops near
the thumbnail that you choose and displays the surrounding thumbnails.    Your reactions may be slower
than Kudo's Riffle feature, so when you release the Riffle control, you may have to select a thumbnail 
that is a few frames ahead of the one you wanted.    



Using Drag and Drop with File Manager

You can Open/Create Catalogs and Add/Update file/s and directories by dragging them directly from the right side of 
the File Manager's split screen. (See changing Views in the File Manager Help). Simply click and hold the left mouse 
button on a file name or slection of files and drag and drop on Kudo.



Using Drag and Drop with Applications

You can drag and drop Thumbnails from Kudo into applications which support this feature. Simply click and hold the 
left mouse button on the thumbnail and drag it to the application and drop. Kudo will then search for the original 
image and place it into the application.



Applications which support Drag and Drop.

QuarkXpress v3.1,v3.2 and v3.3
Aldus PageMakerv4.2 and v5.0
Microsoft Word v2.0 and v6.0
Word Perfect v6.0

Note : The Place Module for the application you are using must be installed in the Kudo directory. The format of the 
file must be supported by that application.

(For further details see Drag and Drop images from Kudo in you User's Guide.).



Keyboard Short Cuts

File Menu
Print Ctrl+P
Exit Alt+F4

Edit Menu
Copy Thumbnail Ctrl+C
Paste Thumbnail Ctrl+V

View Menu
Small Gallery Ctrl+S
Gallery Ctrl+G
List Ctrl+L

Image Menu
Preview Ctrl+E
Get Info Ctrl+I
Find Ctrl+F
Find All Ctrl+A

Help F1



Self Contained Catalog?

When Kudo creates its standard Catalog it produces a list of thumbnail images including information about the 
location of the images, their size, notes etc. At this point you need to use Kudo Image Browser to open, view and 
search images.

When you use the "Make self contained" command in Kudo, the catalog is converted and becomes a stand alone 
catalog with a built-in Kudo. This allows any user to view the catalog and use many of the features of Kudo such as 
printing, searching etc. Once self contained however you cannot updated or modify the catalog, or use it to create 
new catalogs.

Example uses of a Self Contained Catalog.

Catalog Distribution 

Image distribution 

Custom LOGO. 



Catalog Distribution. 

A Self Contained Catalog can be downloaded by BBS users or given to clients on a disk so they can view a complete 
catalog of all the images you or the BBS have available.



Image Distribution. 

True image distribution is an expanding industry due primarily to the popularity of CD ROM technology. Kudo Image 
Browser becomes a user friendly CD ROM authoring tool with the use of the self contained catalog.

If the images are to be distributed along with the catalog, the ability to preview them is dependent on having the 
relevant image filters. A perfect example of this would be to produce a Syquest or CD-ROM of textures and 
background images in tiff format and along with the catalog and files also the filter for tiff format in this case MTIF.FLT.

Using "Drag and Drop" graphic artists and layout specialists increase productivity. If this is the target market also 
included the place modules for that application. 

Both of these examples benefit from the addition of an installation program. You may obtain an installer for use in CD 
ROM production free of charge for a limited time. If you plan you use self contained for image distribution and would 
like further information plus an installer please contact Tech. Support for further details.



Custom LOGO.

This feature allows you to add a personal touch, your own custom opening screen for your self contained catalogs. 
Include a BMP file 500w x 308h pixels named SPLASH.BMP, in the same directory as your catalog and this will 
become the startup screen when the self contained catalog is launched.



Redistributable Components Listing

Kudo Image Browser
1994 Imspace Systems Corp.
All Rights Reserved
619-272-2600
---------------------------------------------------------------
Warning: The use of this software is governed by a Software License. You may not distribute any other Software 
except self contained catalogs and the files listed below. Please read your Software License for additional terms and 
conditions.

FILTERS ***** C:\KUDO\FILTERS

MEPS.FLT - Encapsulated PostScript File Format
MPCX.FLT - Zsoft Pc Paintbrush File Format
MTIF.FLT - Tiff File Format
MPCD.FLT - Kodak Photo-CD Format
MGIF.FLT - CompuServe GIF Format
MPSD.FLT - Adobe PhotoShop 2.5 Format
MWMF.FLT - Windows Metafile Format
MAVI.FLT - Microsoft Audio-Video Interleaved Format
MMOV.FLT - Apple QuickTime Format
MWAV.FLT - Wave Audio Format
ALDVM.DLL - Kudo Filter DLL
PCDLIB.DLL - Kodak Photo-CD DLL

PLACE MODULES ***** C:\KUDO

MQUARK.KPP - Quark Xpress Place Module
MPM.KPP - Aldus Pagemaker Place Module
MWORD.KPP - Microsoft Word Place Module
MWPW.KPP - WordPerfect 6.0 Place Module

MISCELLANEOUS FILES ***** C:\KUDO

MDATAXFR.DLL
M_QUARK.XXT - Quark Xpress Extension for Kudo Drag & Place
MSVIDEO.DLL

OLE v2.0 DLL Files ***** C:\KUDO

OLE2.REG
KUDO.REG

***** C:\WINDOWS\SYSTEM

BWCC.DLL
COMPOBJ.DLL - OLE Version 2.0 components
OLE2.DLL
OLE2CONV.DLL
OLE2DISP.DLL
OLE2NLS.DLL
OLE2PROX.DLL
STORAGE.DLL



CD ROM Authoring

Purpose
Overview 
Using Kudo Image Browser as a CDROM Authoring Tool 
Step 1 - Plan Ahead 
Step 2 - CDROM Layout 
Step 3 - Creating Your Kudo Catalogs 
Step 4 - Putting it All Together 
Step 5 - Test, Test, Test... 



Purpose
NEXT

This document is intended to help Kudo CD Publisher users plan and create a content based CDROM for Macintosh 
and /or Windows users    for sale, internal corporate distribution or image archiving.      Additional information can be 
obtained by contacting Imspace Systems Corporation.



Overview
NEXT

Creating a successful content CDROM for internal use or for sale to Macintosh and/or Windows users is not difficult.   

1.    The first step is deciding if a CDROM is the way to go. 
2.      Do you want to do it yourself or use a service bureau
3.      Read this document and create a project plan 
4.      Design the CDROM based on a thorough understanding of the intended user
5.      Get all the necessary licenses and releases
6.      Prepare your content
7.      Get your computer equipment setup and tested
8.      Put the content on the hard drive volume that simulates the CDROM
9.      Create a customized Kudo Self Contained catalog of the CDROM volume
10. Write the CDROM one off
11. Test the one off
12. Duplicate the one off 
13. Feel a sense of accomplishment      



What you need
NEXT

If you plan to write CDs in your shop you will    need a CD Writer in addition to a Macintosh and/ or Windows 
computer with at least 1.5 Gigabytes of    free hard disk space.    Your hard disk space should preferably be a single 
disk drive of at least 1.5 Gigabytes with at least 1 Megabyte per second actual data transfer speed.

Your computer should have a high performance 24bit graphics display system with 20 inch color monitor and enough 
system main memory to equal twice the size of your largest image. 

If you plan to use an off site CD Writer you will need removeable media capable of storing 650 Mbytes, such as a 
DAT drive.    Your CD Reader should be at least 2x and preferably 3x.

You will need to purchase the Kudo CD Publisher software CD from Imspace Systems.    Call for pricing and 
availability.



Using Kudo Image Browser as a CDROM Authoring Tool
NEXT

Kudo CD Publisher catalogs can be distributed to other computer users as self contained applications.    This allows 
users who do not have Kudo installed on their systems to use the Kudo catalog.    A self contained Kudo catalog 
offers most of the features of a regular Kudo catalog such as preview original image files, print, Boolean find and drag
& place and has a self executing built in viewer,      A self contained catalog cannot however run or edit an AppleScript,
create a new catalog, open other catalogs, nor may it be updated or modified.

To create a self contained catalog:
1.    Create a Kudo catalog using Kudo CD Publisher.
2.    Make a copy of your catalog.
3.    Select Make Self Contained from the File Menu.

Your Kudo Self Contained Catalog may be distributed royalty free.    Some examples of distribution media are 
CDROM, floppy diskettes, Syquest cartridges, MO cartridges or on line via email or BBS.    Using a compression 
utility such as Stuffit from Aladding Systems or PKZIP from PKWare, you can compress your self contained catalog to
sizes that can quickly be sent via modem.    CDROM developers can use Kudo CD Publisher to prepare cross 
platform CDROMs.

Experienced CDROM developers of content based material such as clip art, stock images, QuickTime movies or 
document images use an CD Publisher as a CDROM front end to provide easy access to the content. Good browsers
have not been available or were too costly - until Kudo CD Publisher began offering the    Make Self Contained 
feature.      This new feature combined with a customizable opening screen,    translator installer and special scripts for
automating keyword management are designed to make Kudo CD Publisher the content developers CDROM 
authoring tool of choice.

Kudo helps meet the needs of content CDROM publishers for an attractive, intuitive, professional, and affordable 
front end that helps sell titles and gives users a pleasurable experience. 



Step 1 - Plan Ahead
NEXT

Imspace Systems has helped many CDROM developers through their first CDROM project.    The first and most 
important step is the project plan. Proper planning can create a rewarding experience and lack of planning can cause 
missed deadlines and painful cost overruns. 

Take the time to think about your intended CDROM user.      Macintosh or Windows users or cross platform.    Are your
intended users professional illustrators, desktop publishers, movie buffs,    voyeurs,    art directors,    scientists ,    
physicians or magazine publishers.

CDROMs for Macintosh users can be created by most CDROM Writers driven by a Macintosh with a 1.5 Gigabyte 
hard disk and formatting software for System 7.1 available from many CDROM Writer vendors.      Windows only 
CDROMs require a 486/33 PC with a 1.5 Gigabyte hard disk and the corresponding formatting software for Windows 
3.1 and are also available from most CDROM Writer vendors.

The cross platform CDROM image should be created and written to the one off CDROM on a Macintosh driven 
CDROM Writer.    Imspace Systems can recommend some reputable vendors.    Please call.

One of the most important decisions regarding your CDROM is what format to use for your images or mixed media 
files.    For Macintosh CDROMs we recommend the PICT format and for Windows CDROMs we recommend the BMP
format.

 For cross platform CDROMs we suggest using TIFF if the image is a raster image or EPS if the image is a vector 
image. These image formats are supported by most programs, on many different platforms, which eliminates the 
need for duplicating your images in several file formats. Remember that if this is going to be a cross platform 
CDROM, your file names MUST conform to the DOS 8.3 filename format (FILENAME.EXT).    

If your images need to be large, say for print production, you may want to use the JPEG file format. The JPEG format
does not yet have the broad support that TIFF, or EPS files enjoy but most major applications such as Quark, 
Pagemaker, and Photoshop can read them.      JPEG drastically reduces your file sizes, allowing you to fit more 
images on your CDROM.    If you use JPEG, we suggest you also include screen resolution TIFF images for quicker 
previewing.

Make sure you have the proper releases and licenses before laying out your CDROM.      For QuickTime movies you 
should get a license to distribute the latest version of QuickTime for Mac and Windows from Apple to ensure your 
users of consistent and predictable performance.



Step 2 - CDROM Layout
NEXT

Imagine you are a customer who just purchased a CDROM with 650MB of images on it, and you are looking for that 
one image that you need. This is when you realize how important it is to have Kudo CD Publisher prepare your 
CDROM, and how important it is to have your CDROM structured in such a way that your customers can find the 
image they need quickly & easily.    The fewer folders you have on the root of the CDROM, the easier it is to use.    
We suggest    two folders only,    on the root,    one called images and another called browser.



Step 3 - Creating Your Kudo Catalogs
NEXT

There are some very important things to keep in mind before you start cataloging.      Kudo makes a thumbnail of the 
original image, and stores the complete path back to the original.    When you choose Preview or use Drag & Place,    
Kudo uses the original file. The path that is stored with each thumbnail in the Kudo catalog cannot be changed after 
you have cataloged the file.    If you are using a hard drive as the premastering drive, you MUST make sure that you 
have it set up in exactly the same way as your final CDROM.    Make certain that your premaster hard drive has the 
same volume name and file structure as your CDROM will, and do not change anything after creating your final Kudo 
catalog. 

If you are creating a cross platform CDROM, and you want to put a Mac & Windows Kudo catalog on it, we have 
some time saving scripts to help you out.

Copyright,    trademark and additional ordering information can be inserted in the catalog as a PICT or BMP image of 
a one page document scanned or printed to disk with DISKPRINT (available on Imspace Systems BBS).    This image
should be no more than 72 dpi,    8 or 24 bit color depth,    screen size and the first image in the catalog.    Screen size 
depends on your intended user.    Graphics professionals have 20 inch or 17 inch 24 bit color monitors    - most 
corporate business presentation creators have 13 inch 8bit color monitors.    Choose your image size and resolution 
according to the needs of your intended customers.



Step 4 - Putting it All Together
Example Windows Layout

Example Mac Layout
NEXT

Once your catalog has been created, you will need to place it on your CDROM with all of the required support files.

On the Macintosh, you will need to put all the Kudo Place Modules in the same folder as the self contained catalog. 
You can obtain a translator installer for your self contained catalogs free of charge for a limited time. (Call us for 
details.)    This translator installer will install the Claris Translators which are required in order to preview all of our 
supported formats.

For Windows, you will need to create a KUDO directory on your CD. Then put your catalog along with all the required 
support files listed in the Kudo readme, and redistributable components documents into the Kudo directory. For more 
information please refer to the Kudo CD Publisher readme, and redistributable components documents. You may 
obtain a free installer for a limited time, that will install the necessary OLE v2.0 support files. (OLE v2.0 files are 
required for Copy & Paste to work.)

A new feature available in Kudo CD Publisher v1.1 is the ability to replace the Kudo Self Contained opening screen 
with your own custom image. (e.g. Your corporate logo.)    This feature adds a great deal of professionalism to your 
catalogs. 

To insert your image on the Macintosh just place a PICT file named Splash in the same folder as your Kudo self 
contained catalog. The image dimensions should be 500w x 308h pixels. We suggest you use an 8 bit image, but you
can insert a 24bit if you choose. The image you use MUST be under 500k and be a Macintosh PICT file.    Dont forget
that monitor screen resolution is 72dpi anything more is a waste because this image is meant for screen viewing only.

To insert your image in Windows just place a BMP file named SPLASH.BMP in the same directory as your Kudo self 
contained catalog. The image dimensions should be 500w x 308h pixels. We suggest you use an 8 bit image, but you
can insert a 24bit if you choose.    The image you use MUST be a Windows BMP file.

Here is a listing demonstrating a possible layout on your CDROM. This list only details the most important files. You 
should read the Kudo CD Publisher readme, and redistributable components documents for a more complete listing 
of all the required files.

Neato Images CDROM
IMAGES---These directories\folders can be seen by both Mac & Windows.

SCREEN---This directory holds the screen size images for quick previews.
BIG_FILZ---This directory holds the large size images for printing.

Kudo CD Publisher--- This is the Mac Kudo directory and can only be seen on the Macintosh
Neato Self Contained Catalog
Splash
Kudo Readme
Install This First!    --- Claris translator installer, required to preview full size images.

KUDO_WIN --- This is the Windows Kudo directory and can only be seen by Windows
NEATO.KDB
README.TXT
SPLASH.BMP
INSTALL.EXE        --- OLE v2.0 Installer, required for Drag & Drop, and Copy & Paste.



Images

These directories\folders can be seen by both Mac & Windows.

SCREEN---This directory holds the screen size images for quick previews.
BIG_FILZ---This directory holds the large size images for printing.



Kudo Image Browser Mac

This is the Mac Kudo directory and can only be seen on the Macintosh
Neato CD Products - Self Contained Catalog
Splash - Corporate Startup Logo
Kudo Readme - Instructions on use
Installer - Claris translator installer, required to preview full size images.



Kudo Image Browser Windows

This is the Windows Kudo directory and can only be seen by Windows
NEATO.KDB - Self Contained Catalog
README.TXT - Instructions on use
SPLASH.BMP - Corporate Startup Logo
INSTALL.EXE - OLE v2.0 Installer, required for Drag & Drop, and Copy & Paste.



Step 5 - Test, Test, Test...

The final step in creating your CDROM is the testing stage. Youll save a lot of money, and anguish if you just spend a 
few minutes testing your one-off CDROM.    Make sure the place modules are in the same folder as your self 
contained catalog. Try previewing a few images, to make sure you didnt change the path to the images.    And when 
everything looks good, make enough copies for your first few months orders and no more      Find a duplication 
service that gives good prices on runs of less than 1,000 copies.    You can always make more but its expensive to 
throw away thousands of copies because of a mistake that wasnt caught in time.



The Splash Screen

A new feature available in Kudo Image Browser for the Macintosh v1.1.2 & Kudo Image Browser for Windows v1.1 is 
the ability to replace the Kudo Self Contained opening screen with your own custom image. (e.g. Your corporate 
logo.)    This feature adds a great deal of professionalism to your catalogs. 



Example Windows
BACK



Example Macintosh
BACK



Desk Top Publishers
Use Kudo® Image Browser to increase productivity, no more searching for that illusive image simply find it visually or 
use Kudo®'s innovative search capabilities. Then quick as a click drag and place it with pin point accuracy into your 
DTP application.



Illustration Graphics
Keep all you graphics and image files organized with Kudo® Image Browser. Increase productivity using drag and 
drop plus produce catalogs of your work and for distribution on disk or on-line.Use CD Publisher not only publish your
CD ROM catalogs for Mac and Windows but also publish these Catalogs on-line as electronic advertisements.



Presentation graphics
Use Kudo®'s multimedia capabilities to organize graphics, clipart and sound files. Search through hundreds of files, 
use Kudo® as a creative tool previewing sounds and images for your production of business and multimedia 
presentations.



On-line Publishing
Using Kudo® image browser to create self contained catalogs to publish your images on-line on any major or local 
BBS. Simply catalog your images and depending on your platform use a compression utility and upload your catalog 
to any BBS system. Include with your Catalog you custom splash screen and an image file containing your contact 
information pricing etc.



New Kudo®    CD Manager™
Kudo®    Image Browser™ the best image manager for professional Macintosh and Windows graphics users, is now 
available as a CD Manager.    Kudo® CD Manager is the Windows and Macintosh versions of Kudo® Lite. Drag and 
Place all popular file formats into leading graphics, presentation and drawing applications. This package will appeal to
Desk Top Publishers, Educators and Companies involved with graphics and images in a mixed computer 
environment as well as to the casual graphics and computer fax user. 

CD ROM Content
All CD ROM contain a number of self contained catalogs of artwork etc from Image Distributors using the    Kudo® 
range for business and for pleasure.



New Kudo® CD Publisher
Professional CD ROM publishers and creators need all the powerful features of Kudo® CD Publisher - with 
AppleScript for automating repetitive chores, utilities written specifically to aid in the production of CD titles. Best of all
create Royalty FREE run time catalogs, YES a fully functional read only version of the Kudo® image browser built 
into your CD Catalog. Your users can search, drag drop and place graphics as quick as a click. 

Use CD Publisher to author your CD Master in Days not months. Comes complete with help files and utilities to aid 
you in your CD Publishing. 

CD ROM Content
All CD ROM contain a number of self contained catalogs of artwork etc from Image Distributors using the    Kudo® 
range for business and for pleasure.



International Versions
Kudo® Image Browser is available in the following International versions.

Kudo® Image Browser for Windows - German Language Version
Kudo® Image Browser for Macintosh - German Language Version
Kudo® Image Browser for Macintosh - Japanese Language Version

Kudo Lite, CD Manager and CD Publisher are in developement for both languages contact Imspace for further 
details.



Kudo Range

New Kudo®    Lite™

Kudo®    Image Browser™ the best image manager for professional Macintosh and Windows graphics users, has 
been joined by Kudo Lite.    Kudo Lite is for the casual graphics and computer fax user.      Kudo Lite Mac retails for 
$49.95, comes in a retail shelf package and has all the powerful features of Kudo Image Browser except for:

1) no royalty free run time catalog creation    
2) no AppleScript support    
3) no Scitex CT or Photoshop file support.

Kudo Lite Win retails for $39.95 and has all the features of Kudo except for:
1) no royalty free run time catalog creation
2) no PhotoShop file support

Why buy Kudo® Lite™?

Occasional desktop publishers or graphics designers on the Mac or presentation graphics creators on Windows and 
computer fax users need Kudo Lite to help organize, find and place graphics.    

Why buy Kudo® Image Browser?

Professional desktop publishers, graphics designers, illustrators, digital photographers, PrePress shops, and 
business presentation creators need all the powerful features of Kudo Image Browser - with AppleScript for 
automating repetitive chores, run time catalogs for digital image publishing and high performance Scitex CT and 
Photoshop file support.

When can I buy Kudo® Image Browser™and Kudo® Lite™?

Kudo Image Browser Mac v1.1.2 , Kudo Lite Mac v1.1.2 and Kudo Lite Win v1.1 are shipping now.    Kudo Image 
Browser Win v1.1 will ship soon.    Registered users who purchased Kudo Image Browser for Windows v1.0    after 
April 1, 1994 will receive a free upgrade to v1.1 upon proof of purchase.    Registered users who purchased Kudo 
Image Browser for Mac v1.1    after April 1, 1994 will receive a free upgrade to v1.1.2 upon proof of purchase. 

Where to buy Kudo® Image Browser™and Kudo® Lite™

Kudo Image Browser and Kudo Lite are available at most local computer software and mail order software resellers.   
Upgrades are available for registered users direct from Imspace Systems Corporation for $49.00 plus $5.00 shipping 
and handling.

June 28, 1994
Kudo for Macintosh can be purchased from    the 
merchants listed below:

Kudo Mac v1.1 
Order#

Kudo Lite Mac v1.1    
Order#

MacWarehouse---800-255-6227 GRA 0516 GRA 0768
MacZone---800-248-0800 M98376 M97322
Macs Place---800-814-0009 8491 8492
PrePress Direct---800-443-6600 ISO17 ISO18
DTP Direct---800-395-7778 33-00102 33-00103
Mac Connection--800-800-2222 TBA TBA
Egghead---800-359-3447 312447 842468
Imspace Systems Corp.--800-488-5836 SRP $195.00 SRP $49.95

Kudo for Windows can be purchased from the 
merchants listed below:

Kudo Win v1.1 
Order#

Kudo Lite Win v1.1 Order#

MicroWarehouse---800-367-6808 GR7793 GR



PC Zone---800-258-2088 W14465 W14459
PC Connection--800-800-5555 TBA TBA
PrePress Direct---800-443-6600 ISO19 ISO20
DTP Direct---800-395-7778 33-00104 33-00120
Computer Outfitters---800-254-0009 51274 52215
Egghead---800-359-3447 842450 842476
Imspace Systems Corp.--800-488-5836 SRP $145.00 SRP $39.95

Kudo® Image Browser™ and Kudo® Lite™ for Macintosh

Kudo® Image Browser and Kudo® Lite for Windows

Brought to you by the Kudo team at Imspace Systems Corporation prices subject to change without notice.




